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SDS HELPDESK TUTORIAL

Welcome
Welcome to the SDS HelpDesk.  This program has been designed to improve your company’s ability to 
provide high quality support and service to your customers.  

SDS HelpDesk turns your raw data into useful information so that you can manage and track all aspects 
needed to resolve customer issues.

How SDS HelpDesk is Organized
The program is organized into nine modules that all work together and share information. The modules 
include:

 
Address Book – Used to enter information about any of your contacts.  It is recommended that 
you start with Address Book whenever a new customer calls.  The information entered in Address
Book is used throughout all of the other modules.  You can view a contact’s issues and service 
contracts directly from Address Book.

Issue Manager – This module is the heart of SDS HelpDesk and is used whenever you talk with 
a customer.  Issue Manager let you categorize issues any way you want to.  It then automates the
collection of related information and tracks the issue until it is resolved.  Use Issue Manager to set
up work groups to resolve an issue and to communicate with work group members.  Start the 
timer in Issue Manager to track the amount of time it takes to resolve an issue.

Service Contracts – Used to manage all of your organization’s service contracts.  Service 
Contract Manager automatically verifies whether a contract is still valid and lets you know directly 
from the Issue Manager module.

Time Tracker – Records the actual and billable hours spent on an issue.  You can search Time 
Tracker by user, organization, contract, issue, dates, and billable or non-billable time.

My Issues – This module displays issues that have been escalated to you by other work group 
members or that you have tasks for.  The SDS HelpDesk messaging system notifies you 
immediately of issues and tasks that have been assigned to you.  You can view your issues 
directly from the My Issues module and track the time you spend working on the issue.

Scheduler – Used to post reminders whenever you cannot resolve an issue immediately and you
need to follow up with a customer.  Scheduler keeps track of all of your follow-up items until they 
are completed.    

Knowledge Base – The Knowledge Base gives you the solutions to repeat issues.  It can also be
used to store general information such as step-by-step instructions, how-to information, lists of 
parts needed to do a job, International System of Measures, temperature conversion, physical 
constants, conversion factors, etc.

Report Manager – Two kinds of reports are available in SDS HelpDesk depending on your 
needs.  SnapShot reports can be previewed and printed directly from the module you are working
in.  They are used when you want to see information for a currently selected record.  
ExecReports are launched from the Report Manager module.  Use these reports when you want 
to see details for groups of records.   

Lookup Tables – This module is a convenient place to create lists of information that are used 
repetitively (e.g., categories, issue locations, skills, priorities, organization names etc.).  The 
information you enter in Lookup Tables appears in the drop-down lists and trees throughout SDS 
HelpDesk.
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What You Need to Know Before Starting the Tutorial
This tutorial assumes that you are familiar with standard Windows terminology and concepts.  If you are 
not, we recommend that you refer to your Windows manual for additional help.

Documentation Standards
The conventions used in this tutorial have been established to help you learn to use SDS HelpDesk 
quickly and easily.  These conventions conform, as much as possible, to those found in other Windows 
documentation.  The following is a summary of the conventions used throughout this tutorial:

Convention Meaning
Click Click the left mouse button once.
Double-click Click the left mouse button twice, fast.
Right-click Click the right mouse button once.
Select Double-click on an item to highlight it.
Press Key + Key Hold down the first key and press the 

second key (e.g., ALT + A).
Menu Names and Options Printed in bold type.
Dialog Box Names Begin with uppercase letters.
Record Related pieces of information.  An 

example is an organization and the 
information related to it such as 
contacts, issues, and service contracts.

Field A category of information such as name
or address.

How to Get Help
If you have a question about this tutorial or the SDS HelpDesk program, you can Email us at 
support@ScottDataSystems.com.
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How to Install SDS HelpDesk

System Requirements
 Windows 95, Windows 98, or Windows NT 4.0.

 IBM-compatible PC with 486DX2/66 or higher microprocessor.

 16 megabytes of RAM.  32 megabytes of RAM is recommended.

 Hard drive with 25 megabytes of free disk space.

NOTE:  This is the amount of free disk space needed to install the program and system files.  The amount of 
disk space needed to run SDS HelpDesk depends on the amount of data you enter into the program.

 SVGA (800 x 600) resolution video display.

 Mouse.

 Printer.

Installation Instructions
The software you have just downloaded has been compressed into a self-extracting executable file.  
Move this file to its own directory or to a zip disk for safekeeping.

1. Double-click on the file.  A dialog box will open.  If you want to unzip the installation files to a different 
directory, change the path in the Unzip to Folder edit box.  Click the Unzip button.  The file will 
decompress itself into over a hundred separate files.

2. Before proceeding with the installation, close all applications that are currently running.

3. Double-click the file called setup.exe.  The installation program will now start.  Follow any instructions
provided by the installation program.  A shortcut to the SDS HelpDesk program will be created in your
Start Menu.

4. SDS HelpDesk starts the same way as other Windows programs.  Click the Start button.  Select the 
Programs option.  Click the SDS HelpDesk shortcut and then the SDS HelpDesk program.

5. Several initial screens will greet you.  The first screen will be a welcome screen that is shown only 
once.  The next screen is the Start Wizard. 

Start Wizard
The Start Wizard can be used to pre-configure the login screen.  Until you check the “Hide this Screen” 
box (bottom left-hand corner), the Start Wizard opens whenever you start SDS HelpDesk.  To launch the 
Start Wizard after the “Hide this Screen” box is checked, click the Help menu.  Select the Show Start 
Wizard option.
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Start Wizard (cont’d)

1. The first button is used to connect to the Demo database and login as the administrator.  The 
default password for the administrator is “admin.”  It has been entered for you automatically.  The 
default path to the Demo database has also been entered for you.  Just click the OK button.

2. The second button is used to connect to the Demo database but login as the user, CBROOKS.  
The password for all Demo users is “hi.” It has been entered for you automatically.  The default path 
to the Demo database has also been entered for you.  Just click the OK button.

3. The third button is used to connect to the SDS HelpDesk database (HelpDesk.mdb) and login as 
the administrator. The default password for the administrator is “admin.”  It has been entered for you
automatically.  The default path to the HelpDesk database has also been entered for you.  Just click 
the OK button.

4. Once you have entered your own information into the HelpDesk database, you can click the fourth 
button whenever you want to log onto it.  Your user name will be entered for you automatically.  If 
you previously logged onto the program as a different user or as the administrator, that user name 
will be displayed.  Enter your password and click the OK button.

You can change your password at any time using the Modules menu, Change Password option.  
You can also check the Remember Password box.  This will save you from typing in your password. 
It is recommended that you leave this box unchecked if multiple people have access to your 
computer. 

NOTE:  FOR THIS TUTORIAL, CLICK THE SECOND BUTTON TO CONNECT TO THE DEMO DATABASE AND 
LOGIN AS THE USER, CBROOKS.  WHEN THE SECOND BUTTON IS CLICKED, THE LOGIN SCREEN OPENS.  
IT HAS BEEN PRECONFIGURED TO CBROOKS AND INCLUDES THE DEFAULT PASSWORD FOR ALL DEMO 
USERS WHICH IS “HI.”  THE PATH TO THE DEMO DATABASE IS ALSO PRECONFIGURED FOR YOU.  JUST 
CLICK THE OK BUTTON.  THE DEMO DATABASE CONTAINS SAMPLE CONTACTS, SERVICE CONTRACTS, 
ISSUES, TIME TRACKER ENTRIES, KNOWLEDGE BASE ENTRIES, AND LOOKUP TABLE INFORMATION.

The next two screens you will see are the Setup Wizard and the Work Flow Wizard.  These screens can
be used to help you set up your own help desk database.  They are self-explanatory and are not covered 
in this tutorial.
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How to Move the Database File to a Network Server
In a multi-user environment you probably will want everyone to be using the same database. 

1. Once you have followed the installation instructions for each user, you can move the HelpDesk 
database to a network server.

2. Create a SDS HelpDesk folder in the route directory of the server.  Select the HelpDesk folder and 
then create a subfolder of it called Database.

3. Move the database file (called HelpDesk.mdb) from your local computer into the Database folder on 
the server.  This step only needs to be done once by the system administrator.   

4. Each licensed user then needs to set the path to the database file on the server.  This is done 
through the File menu, Login option.

License Agreement and Code
Users of SDS HelpDesk must have a valid SDS Software License and license code. There are two types 
of license codes.  One is a temporary code, which expires after a reasonable evaluation period.  Your 
temporary demo code is entered for you automatically when you install SDS HelpDesk.  The other is a 
permanent code.  This code is given to users who register and purchase the software.  Once you register 
the program, email Scott Data Systems for a permanent license code.  

A dialog box opens when the evaluation period expires on a demo license code.  Close the dialog box.  
Click the Help menu and then select the How to Register option.  This will provide instructions on how to
register the program and obtain a permanent license code.
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Updating your SDS HelpDesk License Code
You need to update your SDS License Code when you register the program or if you need additional 
evaluation time on a demo license.  Click the Help menu and select the How to Register option.  This will
provide instructions on how to register the program and obtain a permanent license code.

1. Click the File menu.  Select the License option to open the following dialog box.

2. Enter the new license code in the edit box.

3. Click the Done button.
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User Login
Whenever you start SDS HelpDesk you will be asked to enter your password.  The system administrator 
must set up users and their initial passwords from the Admin, Users menu option.

1. When you start the program, the last user name entered is the one displayed in the edit box.  If 
necessary, enter your user name into the User Name edit box.

2. Enter your password in the Password edit box.  Click the OK button.

3. You will be notified if you enter an invalid password.

NOTE:  User Names and Passwords are case sensitive, so be sure to enter yours correctly.

You can change your password at any time by using the Modules menu, Change Password option.  You
can also check the Remember Password box.  This will save you from having to type in your password.  
IT IS RECOMMENDED THAT YOU LEAVE THE REMEMBER PASSWORD BOX UNCHECKED IF 
MULTIPLE PEOPLE HAVE ACCESS TO YOUR COMPUTER.
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Getting to Know SDS HelpDesk
The main window is displayed when you start SDS HelpDesk.  The major elements found in this window 
are the Main Menu, the Toolbar, and the Status Bar.  

Main SDS HelpDesk Window

The Main Menu
Each item on the menu bar opens a drop down list of commands.   The menu bar items include File, 
Admin, Modules, Window, and Help.  The commands let you perform specific operations, open dialog 
boxes to enter needed information, or login to the SDS HelpDesk database.

 File Menu – The File Menu includes commands to enter or change your SDS License Code, log onto 
an SDS HelpDesk database, refresh the database information, or exit the program.

 Admin Menu – This menu is available only to users with system administrator permissions.  It 
includes commands to view user logons, add users, view locked record information, enter your 
organization name, change the path to the Help and reports files, set service contract and issue code 
formats, and customize certain labels.

 Modules Menu – Each of the modules can be launched from this menu.  It also includes commands 
to change a password, prompt when adding information on-the-fly, change workstation fonts, hide the
initial splash screen, and display raised or depressed module sections.

 Window Menu – Use this menu to set how individual windows are displayed on the screen.  With 
SDS HelpDesk, you can open multiple copies of the same module.

 Help Menu –The Help menu is used to activate the on-line help file, launch the Start, Steup, or Work 
Flow Wizards, find out how to register SDS HelpDesk, or to find out about this version of SDS 
HelpDesk.
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The Toolbar
The toolbar provides shortcuts to HelpDesk modules and lets you know when an issue has been sent to 
you for review.

Selecting Items from a Drop-Down Tree
Drop-down trees are used throughout SDS HelpDesk to enter repetitive data (e.g., categories, 
subcategories, issue locations, or conditions).  The information that is entered in Lookup Tables is 
displayed in the various drop-down trees. 

1. Open a module (e.g., Issue Manager).  You will see large buttons next to the Category, Location, and 
Condition boxes..

2. Click the large button to view the drop-down tree.

3. The tree format enables you to view the hierarchy of items.  A plus (+) next to an item means that 
there is another level below it.  Click the plus (+) to see the next level.  Double-click the lowest level 
item and it and all of the levels above it are entered for you automatically.

Selecting Items from a Lookup Table
You can enter repetitive data (e.g., organization, location, condition, status, priority, skills) directly from 
Lookup Tables.  Lookup Tables are also used to enter new information into drop-down trees and boxes or
to modify currently existing repetitive data.  The information that is entered in Lookup tables is displayed 
in the various drop-down trees.  

1. Open a module.  You will see small buttons next to the drop-down boxes.

2. Click the small button to launch the associated Lookup Table.  Double-click on the item you want and 
it is entered for you automatically.

Mandatory Fields
Some fields are mandatory and need to be entered.  A green box surrounds the mandatory fields in each 
module.  The Add button does not become active until the mandatory fields are filled in.

About this Tutorial
This is a hands-on tutorial that is intended to be used with the demo database.  The tasks refer to what is 
on the screen and in the various drop-down trees or Lookup Tables.  This tutorial will not make as much 
sense if you are just reading and not actually using the program.

The way categories/subcategories and issue locations are set up in the demo database is just an 
example.  We encourage you to experiment with other ways that may be appropriate for your particular 
company.

By using this tutorial you will learn how to:

1. Add a new contact.

2. Add a skill to an existing contact.

3. View an existing contract and issue from Address Book.

4. Verify and add a new service contract.

5. Enable Issue record locking.
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About this Tutorial (cont’d)
6. Add a new issue.

7. Verify and view service contract information from Issue Manager.

8. Add issue conditions and values.

9. Set up an issue work group and escalate an issue to a work group member.

10.Add a resolved issue to the Knowledge Base.

11.View work group messages.

12.Preview a SnapShot report.

13.View items in the My Issue module.

14.Track time spent on an issue.

15.Add a follow-up item.

16.Preview an ExecReport.

17.Search the Knowledge Base.

18.Add yourself as a new user.

19.Add new items to Lookup Tables.
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YOU ARE NOW READY TO START USING SDS HELPDESK 

SCENARIO
Your name is Charles Brooks.  You work for a company called Bentley Industries, which produces 
telephone equipment.  You are responsible for providing both internal and external customer support.  A 
new customer has experienced a problem with your equipment and has called your technical support line.

Task 1: Add the new contact

1. Click the Address Book             icon in the toolbar to open the module.

Address Book Manager

NOTE:  The green boxes around the contact name and organization fields indicate that these are mandatory 
fields and must be filled in.  You can add a generic organization such as “individual” or “none” if the contact 
is not associated with an organization. 

2. The new contact is Jane Samuels and she is with Packard Brothers, Inc.  Since you are not sure 
whether Packard Brothers is already in the database, click on the small button next to the 
Organization drop-down box.  This launches Lookup Tables.  Scroll down the list to see if Packard 
Brothers is there.  If it is, double-click the name and it is entered for you automatically.  Since 
Packard Brothers, Inc. is not in the database, type Packard Brothers, Inc. in the Description box.  
Click the Lookup Table Add button, and then double-click Packard Brothers, Inc. in the Table Items 
box.  The Lookup Table will close and the name will be entered for you automatically.
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Task 1 (cont’d)
3. Type the contact name, Jane Samuels, into the Contact edit box.

4. Contacts can be classified into various groups depending on your relationship with them.  Select 
Customer from the Contact Type drop-down list.  

5. Add other information in the boxes provided.  For our purposes, enter the following:
Office Phone: (555) 452-1234
Address 1: 1998 Main Street
Address 2: Suite 401
City: Anywhere
State: CO
Zip: 80111
Country: USA

6. Type any special notes about this customer in the Notes box.  This can be any information that may 
be helpful to you such as special days or hours the customer is available, spouse name, birthday, etc.
You can enter up to 256 characters in the Notes box.

8. When you are finished entering all of the customer information, click the Address Book Add button 
which is located in the upper right portion of the module screen.  This saves all of the information to 
the database.

9. If, after you click the Add button, you find that you want to add additional information or you want to 
correct any errors you made when entering data, make your changes and then click the Update 
button.

10. Close Address Book.

Task 2: Add a Skill to an Existing Contact
You need to add a new skill to one of the Bentley employee records.

1. Select Bentley Industries from the Organization drop-down list.  Click the Find button.  Use the first, 
previous, next, and last buttons in the bottom right corner of the module to scroll through the contacts.
Stop at any contact you want.

2. Click the small button next to the Skills drop-down box to open the Skills Lookup Table.  Double-
click a skill that you want to add for this contact.  This will close the Lookup Table.

3. The skill you selected is displayed in the Skills edit box.  Click the Skills Add button. 

4. Click the Update button to save your modification.
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Task 3: View an Existing Contract and Issue from Address Book
Once you select an organization, you can view related contracts and/or issues directly from the Address 
Book module.

1. Select Advanced Machine Company from the organization drop-down list.  Click the View 
Contracts button.  This launches the Service Contract module and automatically searches for all 
contracts you have with this organization.  If there is only one contract, it is displayed.  If there are 
multiple contracts, you can select a contract from the Contract drop-down list or you can scroll 
through the contracts by using the first, previous, next, and last buttons in the bottom right corner of 
the module.  

2. Close the Service Contract module.  The Address Book module should still be visible.  Click the View 
Issues button.  This launches the Issue Manager module.

  NOTE:  The first time you open Issue Manager you will be greeted with the Issue Record Locking screen.  If 
you have Administrator privileges, you can enable issue record locking.  Record locking is used primarily in 
multi-user environments.  Once enabled, it protects issues from being modified by multiple users at the 
same time.  When record locking is enabled, a narrow red border surrounds the Issue screen, the screen 
controls are locked, and users must click the Edit button before modifying an issue.  Once the Edit button is 
clicked, the border turns green, the screen controls are unlocked, and changes can be made to the issue.  
Click the Update button to save your changes.

FOR THIS TUTORIAL, JUST CLICK THE OK BUTTON TO CLOSE THE RECORD LOCKING SCREEN.

3. SDS HelpDesk has searched the database for all issues related to Advanced Machine Company.  
The issues are listed in a pop-up screen.  Click any of the issues to see a quick view of key 
information.  The Sel button is used to load the issue into the current Issue Manager screen.  If you 
are working on a new issue and you don’t want to overwrite it, use the Open button to load the 
selected issue into another screen.  This is useful when you want to copy and paste a solution from 
one issue to another issue.  The Dup button is used when you want to use the selected issue as a 
template.  The Hide button closes the pop-up screen.  

4. Click the first pop-up screen Hide button, and then click the second pop-up screen Hide button.

5. Close the Issue Manager module, and then close the Address Book module.  
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Task 4: Verify and Add a New Service Contract

Bentley Industries offers various service contracts to customers to cover technical support.  You need to 
verify whether Packard Brothers has a valid service contract.  Since it does not, you need to add a new 
service contract.

NOTE:  You will need to refer to your company policy on how to proceed with the customer if the service 
contract is no longer valid or a contract does not exist.

STEPS:

1. Click the Service Contracts icon            in the toolbar to open the module.

Service Contract Manager

NOTE:  The green box around the Organization field indicates that this is a mandatory field and must be filled
in for each contract.

2. Click the small button next to Organization to open the Lookup Table.  Double-click Packard 
Brothers.  Since you just added Jane Samuels as a contact, her name is entered for you 
automatically.  If there are multiple contacts, select the appropriate one from the Contact drop-down 
list.

3. Select a service level from the Level drop-down list, or click the small button next to Level to select 
from the Lookup Table.  Service levels can include such items as unlimited, limited, warranty, per-
incident, phone support, on-site, etc.  Select the Basic level.

4. Select a time period that the service contract is in effect from the Duration drop-down list, or click the 
small button to select from the Lookup Table.  Duration can include such items as Annual, 30-day, 
Quarterly, etc.  Select the Annual duration.

Page 14

This box is green for valid 
contracts, and red for expired 
or cancelled contracts.



SDS HELPDESK TUTORIAL

Task 4 (cont’d)
5. Enter the date in the Start Date box or click the small button to select a date from the Calendar.  

Service Contract Manager automatically calculates and enters the end date for you depending on the 
Duration you selected.

NOTE:  If you select a per-incident contract level, you do not need to enter a duration.  However, you do need
to select the number of issues covered by the contract from the Limit drop-down list, or click the small 
button to select from the Lookup Table.

6. You can enter a contract price or rate in the Rate box.  

7. Enter any appropriate contract notes in the Notes area.   

8. When finished, click the Add button.  A new contract number is displayed in the Contract field.  When
a contract is valid, the Status button turns green.  If a contract is not valid, the Status button remains 
red. 

9. If, after you click the Add button, you find that you want to change any information or you want to 
correct any errors you made when entering data, make your changes and then click the Update 
button.

10. Close the Service Contract module.

Task 5: Add a New Issue
You need to record information about the problem that Jane is having with your equipment.  This includes
categorizing the issue, documenting which piece of equipment she is having a problem with, and entering 
a description of the problem.

STEPS:

1. Click the Issue Manager icon  in the toolbar to open the module.
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Task 5 (cont’d)

Issue Manager

NOTE:  The green boxes around the Organization and Category fields indicate that these are mandatory 
fields and must be filled in for each issue.

2. Click the small button next to Organization to open the Lookup Table.  Double-click Packard 
Brothers.  SDS HelpDesk automatically searches for the contacts at Packard Brothers and for 
associated service contracts.  Since Jane is the only contact, her name is displayed in the Contact 
box.  If there are multiple contacts, select the name of the contact with an issue to report from the 
Contact drop-down list.

3. Check the Contracts portion of the screen (upper left-hand corner).  You will see that the small 
Contract box is green which indicates a valid service contract.  The small box is red if the contract has
expired or there is no contract.  You will need to refer to your company policy on how to proceed
if the organization does not have a valid service contract.

NOTE:  If you open Issue Manager before you enter the new contract for Packard Brothers, you can enter the 
new contract now.  Click the Contract label to launch Service Contracts.  Since you launched Service 
Contracts from Issue Manager, the organization and contact name are entered for you automatically.  
Proceed with the steps shown in Task 4.  When finished, close Service Contracts.  You will be returned to 
your place in Issue Manager.

4. Jane has told you that the new message alert display on her ExecuPhone has some of the letters 
missing or cut off.  Type a brief summary of this information in the Problem box.  Click the 
problem Expand button if you need more room.
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Task 5 (cont’d)
5. Most issues can be grouped into general categories such as product defect, how-to question, feature 

wish, warranty work, broken equipment, etc.  These groupings give you a quick way to track and 
compare similar issues.  Some issues can be broken down further into subcategories. Click the large 
button next to Category to open the drop-down tree, or click the small button to select from the 
Lookup Table.  A plus (+) next to a category means that it has one or more subcategories.  Since 
Jane’s issue is with one of our telephones, click the plus (+) next to Telephone to see the 
subcategory level.  Double-click Problem.  The issue category and subcategory are entered for you 
automatically.

6. The Location box is used to identify where an issue has occurred.  The box can represent up to four 
location levels.  As you go down each level, the location category gets more precise.   

Click large button next to Location to open the drop-down tree, or click the small button to select 
from the Lookup Table.  A plus (+) next to a location means that it has one or more levels below it.  
Click the plus (+) next to Products.  Since Jane told you she had an ExecuPhone, click the plus 
(+) next to Multiple Line Telephones.  Click the plus (+) next to ExecuPhone to see the two 
model numbers.  Double-click Model 1432.  The model and all of its higher levels are filled in for you
automatically.  

7. You can also record various conditions that may have an influence on an issue.  For example, 
manufacturing environments have different production lines, multiple labor shifts, and different tools 
or machinery.  Like categories, each of these “conditions” can have multiple subcategories, called 
“values.”  

Click the large button next to Condition to open the drop-down tree, or click the small button to 
select from the Lookup Table.  Click the plus (+) next to a condition to view its values.  Double-click 
any of the values and it and its associated Condition are entered for you automatically.

NOTE:  Unlike the Category and Location drop-down trees, the Condition drop-down tree does not 
automatically close.  This is because you may want to enter multiple conditions.  To add multiple conditions, 
double-click the value to select it.  Repeat the process until you have entered all of the appropriate 
conditions and values.  Click the large button to close the drop-down tree.

8. Select your user name from the User drop down list.

9. Since this is a new issue, select Open from the Status drop-down list.

10. You can indicate this issue’s importance by selecting a priority from the Priority drop-down list.

11. When you have finished adding the minimum information (organization, category, user, and problem),
and any other information that may be necessary for you to resolve the issue, click the Issue Manager
Add button.

12. The Date Opened field is filled in automatically for you when the issue is added.  If the issue needs to
be resolved by a certain date, enter the date in the Promise Date field or click the small button to 
select the date from the calendar. 

13. If, after you click the Add button, you find that you want to add additional information or you want to 
correct any errors you made when entering data, make your changes and then click the Update 
button.

NOTE:  If your organization enabled record locking, you will need to click the Edit button before you can 
modify an existing issue. 

Page 17



SDS HELPDESK TUTORIAL

Task 6: Set Up an Issue Work Group and Escalate the Issue to 
Another Work Group Member
Jane’s issue is one that cannot be resolved over the phone.  A defective part needs to be replaced by one
of your technicians.  You need to add a technician to the issue work group, and then send the issue and a
message to the technician asking him to replace the defective part.  

STEPS:

1. Make sure the issue you just added for Jane is displayed.  Click the Group button to open the Issue 
Work Group dialog box.  The employees who have been designated as users of SDS HelpDesk are 
listed in the large box on the left.

NOTE: Contacts must be designated as SDS HelpDesk users before they can be added to a work group. 

Work Group Dialog Box

2. We need to find a user who has telephone repair experience.  Select Employee from the Contact 
Type drop-down list.

3. Select Telephone Repair from the Skill drop down list.  If you enter a “T” in the box, the list will scroll 
to that area.  Click the Find button.  The users who are employees and who have the skill of 
telephone repair are listed in the left-hand box.  Joe Denton is the only user who meets these search 
criteria.

4. Select Joe’s name.  Click the Add button.  Joe is now listed in the right hand box as a work group 
member

5. Highlight Telephone Repair in the Skill box.  Click the delete key on your keyboard to clear the box.  
Click the Find button.  The other users are now displayed.  Add Charles Brooks as a work group 
member.  
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Task 6 (cont’d)

6. Select JDENTON in the Work Group Members box.  Select a task from the Task Assignment drop-
down box.  Click the Update button.  Close the Work Group screen. 

7. You want to send a message to Joe that asks him to review Jane’s issue and then contact her to set 
up a time to replace the defective part.  Click the Notes button to open the Work Group Notes dialog 
box.  The box displays any previous notes that have been sent between work group members.  This 
is a Read Only box and cannot be edited.

8. Click the Add button to open the Add Notes to Issue dialog box.  Type your message to Joe in the 
box.  Be sure to check your message before exiting.  Once you exit, you cannot edit the 
message.

9. Click the Done button.  Your message is date and time stamped and logged into Issue Notes.  It and 
the issue are sent immediately to the work group members.  Members are alerted that an issue has 
been sent to them.

10. Click the Exit button to close the Issue Notes screen.  Click the Exit button to close the Work Group 
screen.

Task 7: Add a Resolved Issue to the Knowledge Base
You may want to add certain issues to the Knowledge Base so that others can view how the issue was 
resolved.  This can be very helpful with issues or how-to questions that occur repeatedly.

STEPS:

1. Make sure that the issue you added for Jane Samuels at Packard Brothers is displayed.  If it is not, 
select Packard Brothers from the Organization drop-down list, and then click the Find button.

2. Select the issue from the pop-up list, and then click the Sel button from the second pop-up screen.

NOTE:  If your organization has enabled Record Locking, click the Edit button before proceeding to Step 3.

3. Type the following into the Solution box.
“This problem was caused by a defective display screen, part #MA90456.  This part has had 
problems in the past and is being recalled by the manufacturer.  The replacement part is #MA10000.”

4. Click the Update button.

5. Click the Add to Knowledge Base button.  The category, location, problem and solution are added 
to the Knowledge Base.
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Task 8: Logon as Joe Denton and View the Message
When an issue or message is sent to you, you need to know right away so that you can take whatever 
action is necessary.  SDS HelpDesk uses an unobtrusive, yet continually visible, messaging system that 
alerts you immediately when an issue or message is sent to you.

This portion of the messaging system is located in the upper right corner of the main SDS HelpDesk 
window.

STEPS:

1. You are currently logged in as CBROOKS.  You now want to log in as JDENTON.  Click the File 
menu and select the Logout option.  The message box has been grayed out.  Click the File menu 
again, and select the Login option.  The Login dialog box opens and CBROOKS is highlighted.  Type
JDENTON into the User Name box.  Since all user name passwords are the same in the Demo 
database, just click the OK button. 

2. You should see JDENTON and the green New box.  Click the My Issues              icon in the toolbar.  
This launches the My Issues module.    

3. The My Issues module lists issues that have been sent to you by other work group members as well 
as issues that you have tasks for.  Select an issue from the list and then click the View Issue button.  
SDS HelpDesk launches the Issue Manager module and displays the issue.   

4. Click the Notes button to see Charlie’s message.  Send a response back to Charles or close the 
Issue Notes screen.  Close any open messaging screens.

5. Joe wants to see a SnapShot report for this issue.  Click the Preview button.  If you want a printout of
the report, click the printer icon at the top of the preview screen.  Close the preview screen. 

6. You can track the time spent on an issue in two ways.  If you are in Issue Manager, you can select 
an issue and then click the Start Timer button that is located in the bottom right-hand corner of the 
module.  Let some time pass and then click the button again (it now says Stop Timer) to stop the 
timer.  Once the time is stopped, the Time Sheet Entry dialog box opens.  Use this dialog box to 
modify the actual time, select billable or non-billable time, or select the task to record time for.  Click 
the Make Time Entry button.

If you are in My Issues, select an issue and then click the Start Timer button.  Let some time pass 
and then click the button again (it now says Stop Timer) to stop the timer.  You can start and stop the
timer as often as needed.  The total time is an accumulation of all of the elapsed time needed to 
resolve or work on the issue.     

7. When you have finished providing your input or action on an issue, you can delete it from your My 
Issues list.  Select an issue from the list and then click the Remove button.  This only removes the 
issue from Joe’s list, not other work group member lists, or from Issue Manager. 
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Task 9: Check the Time Spent on an Issue
Use the Time Tracker module to track the amount of time you spend resolving an issue.  It not only 
displays the total time, but it also displays the time you spend on each task associated with the issue.  
You can search using just about any field and you can also track billable hours.

STEPS:

1. Click the Time Tracker             icon in the toolbar to open the module.

Time Tracker Module

2. Select JDENTON from the User drop-down list.  Check the box to the right of User to set it as a 
search criterion.

3. Select Packard Brothers from the Organization drop-down list or click the small button to select from
the Lookup Table.  Check the box to the right of Organization to set it as another search criterion.

4. Click the Find button.  The issue is listed in the Time Entries grid.  Select it to see the actual hours 
spent on a particular task as well as the total hours spent on the issue.

5. To add an additional task, select a task from the Task drop-down list.  Click the Add button, and then 
click the Update button.

6. Click the Preview button to see a SnapShot report.  Those items you selected as your search criteria 
are listed in the Selected Filters portion of the report.

7. Close the Time Tracker module.
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Task 10: Logon as Charles Brooks and Enter a Follow-up Item
Since Charles Brooks took the original call from Jane, he needs to let her know what action is going to be 
taken to resolve her issue.  He needs to enter a follow-up item to call Jane once he hears back from Joe.

STEPS:

1. You are currently logged in as JDENTON.  You now want to log in as CBROOKS.  Click the File 
menu and select the Logout option.  The message box has been grayed out.  Click the File menu 
again, and select the Login option.  The Login dialog box opens and JDENTON is highlighted.  Type 
CBROOKS into the User Name box.  Since all user name passwords are the same in the Demo 
database, just click the OK button. 

2. Click the Scheduler     icon in the toolbar to open the module.

Scheduler Module

NOTE:  The green boxes around the Organization and Contact fields indicate that these are mandatory fields 
and must be filled in for each follow-up item.  You can add a generic organization such as “individual” or 
“none” if the contact is not associated with an organization.

3. Select Packard Brothers from the Organization drop-down list or click the small button next to 
Organization to select Packard Brothers from the Lookup Table.  SDS HelpDesk automatically 
searches for the contacts at that organization and displays the first one.  If you need a different 
contact, select the name from the Contact drop-down list.
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Task 10 (cont’d)
4. Use the calendar section of Scheduler to set the follow-up date and time.  When you open Scheduler,

the current date is highlighted in the calendar.

5. If needed, select the follow-up month and year from the appropriate drop-down lists.  Then click a 
date button to select the day the follow-up should occur.

6. Select the follow-up hour and minute times from the appropriate drop-down lists.  Then select either 
the AM or PM radio button.

7. Use the Notes field to enter any information you need for this follow-up item.  Enter a reminder to call 
Jane to let her know when Joe will be able to repair her telephone.

8. When finished, click the Add button.  The contact, date, and time of the follow-up item are displayed 
in the large list box in the upper left corner of the Scheduler screen.  Click on any of the follow-up 
items to see its attached notes. 

9. To enter another new follow-up item, click the Clear button to give you a blank screen.

NOTE:  Whenever you start Scheduler, your list of follow-up items is displayed in the upper left-hand box. 

10. You may want to print out a list of your follow-up items.  You can do this directly from the Scheduler 
module.  Click the Preview button to see the report before it is printed.
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Task 11: Preview ExecReports
ExecReports are used when you need to preview or print out details for groups of records.  

STEPS:

1. Click the Reports icon    in the toolbar to open the module.

Reports Module

2. Select the report from the Available Reports list.

3. Click the Preview button to view the report on your screen.  Click the Printer icon at the top of the 
Preview screen to get a hard copy of the report.

NOTE:  Use the Setup button to select the print range and the number of copies you want. 
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Task 12: Search the Knowledge Base
The SDS HelpDesk Knowledge Base is used to store and retrieve answers to repeat questions or issues. 
It can be used to maintain step-by-step instructions, system configuration information, issue solutions, 
lists of tools and materials to do a job, etc.

STEPS:

1. Click the Knowledge Base icon             in the toolbar to open the module.

Knowledge Base Module

2. Click the Find button to see a pop-up list of Knowledge Base titles.  Double-click any of the titles to 
view its contents.

3. You can also use the category, location, dates, keywords, or title as search criteria.  Since we added 
Jane’s issue to the Knowledge Base, click the large button next to Category to open the drop-down 
tree.  Click the (+) next to Telephones to see the subcategories.  Double-click Problem.  Click the 
Find button.  The first portion of the problem description is displayed in the pop-up screen.  

4. Double-click the title to see the Knowledge Base item.  Change the Title to something more relative 
to this Knowledge Base item (e.g., Defective ExecuPhone Part #MA90456).  Click the Update button.
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Use the Search Engine to Find a Contact
The Search Engine provides a flexible and powerful way to find people and companies in the Address 
Book.  Just about any criteria can be used to find information.

The Search Engine supports “wildcards” so that it is possible to enter just a few letters of a criterion in 
order to find possible matches.  A question mark (?) stands for any single character and an asterisk (*) 
stands for a number of characters.  Wildcards can be placed before, after, or in the middle of other 
characters.

In the following examples a single criterion at a time is used for searching.  Please keep in mind that you 
may narrow the amount of search results by using multiple search criteria at the same time.

Searching for Contacts

Open the Address Book module.  The Address Book module lets you search for people based on first or 
last name, skill, area code, phone extensions, a partial phone number, city, state, zip code, and just about
anything else that the screen has an entry field for.  The Found box displays the number of contacts that 
meet your search criteria.

The following are some Address Book search examples:

Search on Last Name 

1. Click the Clear button.  This gives you a blank Address Book screen.

2. Enter *Scott in the Contact box.  The asterisk represents all characters before Scott.

3. Click the Find button.  The record for Chris Scott is displayed.  Because the asterisk is placed at the 
beginning, if other Contacts also have last names that begin with “Scott” (e.g., Warren Scott, Greg 
McScott), their names will also be included in the search results.  When multiple records are found 
use the first, previous, next, and last buttons in the bottom right-hand portion of the module to 
sequence through the records.

Search by Partial Name 

1. Click the Clear button to give you a blank Address Book screen.

2. Enter *cot* in the Contact box.  The asterisks represent all characters before and after “cot.”

3. Click the Find button.  The record for Chris Scott is displayed.  If other Contacts also have “cot” 
someplace in their name (e.g., Alan Westcott, Bencotten Smith), their names will also be included in 
the search results. When multiple records are found use the first, previous, next, and last buttons in 
the bottom right-hand portion of the module to sequence through the records.

Search on First Name

1. Click the Clear button to give you a blank Address Book screen.

2. Enter Chris* in the Contact box.  The asterisk represents all characters after “Chris.”

3. Click the Find button.  The record for Chris Scott is displayed.  If other Contacts also have first names
that begin with “Chris” (e.g., Chris Jones, Christina Jenkins), their names will also be included in the 
search results. When multiple records are found use the first, previous, next, and last buttons in the 
bottom right-hand portion of the module to sequence through the records.
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Use the Search Engine to Find a Contact (cont’d)
Search by Telephone Number

1. Click the Clear button to give you a blank Address Book screen.

2. Enter *714* in the Office phone number box.  The asterisks represent all characters before and after 
“714.”  When you place an asterisk before and after the number, it doesn’t matter if the phone number
is entered as (714) or 714 or 714-.  Doing it this way will also result in phone numbers that have 714 
anywhere within the number (e.g., 303-555-8714).

3. Click the Find button.  The record for Allen Burton is displayed.  However, the Found box displays a 
“2.”  Another record, the one for Patrick Broge, has also been found.  You can select Patrick Broge 
from the Contact drop-down list or use the first, previous, next, and last buttons in the bottom right-
hand portion of the module to sequence through the records.

4. Click the Clear button.

5. Enter *303* in the Home phone number box.

6. Click the Find button.  The Found box indicates that there are 30 records with the number, 303, in the
phone number.  The first record is displayed. When multiple records are found use the first, previous, 
next, and last buttons in the bottom right-hand portion of the module to sequence through the records.

7. Click the Clear button to give you a blank Address Book screen.

8. Enter (21?)* in the Office phone number box.  The question mark represents one character, while the 
asterisk represents multiple characters.

9. Click the Find button.  Two records are found.  Bob Kunner has a 219 area code and Bryan Riener 
has a 213 area code.  If your area codes are entered without parentheses, enter *21?*.  Your search 
result will be different.  Now four records are found.  One phone number ends with 212, the other has 
the search criterion embedded in the middle of the number.

Search by Zip Code 

1. Click the Clear button to give you a blank Address Book screen.

2. Enter 80027* in the Zip data entry box.  The asterisk represents all characters after “80027.”  Click 
the Find button.  Four records are found. The record for Alan Fine is displayed. When multiple 
records are found use the first, previous, next, and last buttons in the bottom right-hand portion of the 
module to sequence through the records.
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Use the Search Engine to Find a Contact (cont’d)
Search by City 

1. Click the Clear button to give you a blank Address Book screen.

2. Enter Louisville in the City data entry box.

3. Click the Find button.  The record for Alan Fine is displayed.  If you want to type just a part of a city 
name, use an asterisk (e.g., *ville, Louis*, *Louis*). When multiple records are found use the first, 
previous, next, and last buttons in the bottom right-hand portion of the module to sequence through 
the records.

Search by State 

1. Click the Clear button to give you a blank Address Book screen.

2. Enter IN in the Province/State data entry box.  

3. Click the Find button.  Two records are found. The record for Amy Mason is displayed. When multiple
records are found use the first, previous, next, and last buttons in the bottom right-hand portion of the 
module to sequence through the records. If you are not sure of the state code, just type one character
with an asterisk (e.g., *N, C*).  The Search Engine will find all contacts that are located in a state with 
a code that either begins or ends with the letter you entered.

Search by Street Address, Country, Department 

1. Click the Clear button to give you a blank Address Book screen.

2. Enter *Broadway in the Address1 box, USA in the Country box, and 100 in the Department box.  
When multiple criteria are used, the Search Engine looks for contacts that meet ALL the criteria.   

3. Click the Find button.  Twenty-one records are found. The record for Alex Gomez is displayed. When 
multiple records are found use the first, previous, next, and last buttons in the bottom right-hand 
portion of the module to sequence through the records.

Search by Organization 

1. Click the Clear button to give you a blank Address Book screen.

2. Enter *Data* in the Organization box.     

3. Click the Find button.  The records for Scott Data Systems and Data Solutions, Inc. are found.  The 
record for Chris Scott is displayed. When multiple records are found use the first, previous, next, and 
last buttons in the bottom right-hand portion of the module to sequence through the records.
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Use the Search Engine to Find a Contact (cont’d)
Search by Organization Using the Drop-Down List 

1. Click the Clear button to give you a blank Address Book screen.

2. Click the Organization drop-down arrow to see the list of organizations.  Select Allegro Coffee, Inc. 

3. Click the Find button.  The record for Gail Beans at Allegro Coffee is displayed. When multiple 
records are found use the first, previous, next, and last buttons in the bottom right-hand portion of the 
module to sequence through the records.

Search by Organization Using Lookup Tables 

1. Click the Clear button to give you a blank Address Book screen.

2. Click the small button next to Organization to open the Lookup Table.  Double-click on Baker 
Energy.  The Lookup Table will close.    

3. Click the Find button.  The record for Dan Bell of Baker Energy is displayed. When multiple records 
are found use the first, previous, next, and last buttons in the bottom right-hand portion of the module 
to sequence through the records.

Search on Contact Type 

1. Click the Clear button to give you a blank Address Book screen.

2. Type Vendor into the Contact Type box.    

3. Click the Find button.  Twenty-five vendor records are found.  The record for Bob Butterfield is 
displayed.  When multiple records are found use the first, previous, next, and last buttons in the 
bottom right-hand portion of the module to sequence through the records.

Search on Contact Type Using the Drop-Down List 

1. Click the Clear button to give you a blank Address Book screen.

2. Click the Contact Type drop-down arrow to see the selection list.  Select Customer.     

3. Click the Find button.  Twenty-two records are found. When multiple records are found use the first, 
previous, next, and last buttons in the bottom right-hand portion of the module to sequence through 
the records.

Search on Contact Type Using Lookup Tables 

1. Click the Clear button to give you a blank Address Book screen.

2. Click the small button next to Contact Type to open the Lookup Table.  Double-click on Tenant.  
The Lookup Table will close.    

3. Click the Find button.  Four records are found. When multiple records are found use the first, 
previous, next, and last buttons in the bottom right-hand portion of the module to sequence through 
the records.  
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Use the Search Engine to Find a Contact (cont’d)
Search on Title 

1. Click the Clear button to give you a blank Address Book screen.

2. Enter Sales* in the Title data entry box.  The asterisk represents all characters after Sales.    

3. Click the Find button.  Six records are found that start with the keyword “Sales” in the title. When 
multiple records are found use the first, previous, next, and last buttons in the bottom right-hand 
portion of the module to sequence through the records.

Search on Identifier 

1. Click the Clear button to give you a blank Address Book screen.

2. Some contacts, such as internal employees, may have an ID number or a unique number (e.g., social
security) to identify them.  Enter *006 in the Identifier data entry box.  The asterisk represents all 
characters before 006.    

3. Click the Find button.  Three records are found. When multiple records are found use the first, 
previous, next, and last buttons in the bottom right-hand portion of the module to sequence through 
the records.

4. Click the Clear button.

5. Enter VEN-006 in the Identifier data entry box.

6. Click the Find button.  Now only one vendor record is found.

Search on Skill 

1. Click the Clear button to give you a blank Address Book screen.

2. Enter *data* in the Skills data entry box.    

3. Click the Find button.  Two records are found.  One is for a contact with Database Design skills the 
other is for a contact with Data Entry skills.  Use the first, previous, next, and last buttons in the 
bottom right-hand portion of the module to sequence through the records.

Search on Skill Using the Drop- Down List 

1. Click the Clear button to give you a blank Address Book screen.

2. Click the Skills drop-down arrow to see the selection list.  Select Customer Support.  Click the 
Skills Add button.

3. Click the Skills drop-down arrow to open the selection list again.  Select Training.  Click the Skills 
Add button.  You have now set the search criteria for Customer Support AND Training.     

4. Click the Find button.  The record for Kim Christianson is found.  When multiple records are found 
use the first, previous, next, and last buttons in the bottom right-hand portion of the module to 
sequence through the records.
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Use the Search Engine to Find a Contact (cont’d)
Search on Skill Using Lookup Tables 

1. Click the Clear button to give you a blank Address Book screen.

2. Click the small button next to Skills to open the Lookup Table.  Double-click on Heating and 
Plumbing.  The Lookup Table will close.    

3. Click the Find button.  The record for Dan Bell of Baker Energy is found.  When multiple records are 
found, use the first, previous, next, and last buttons in the bottom right-hand portion of the module to 
sequence through the records.

NOTE:   When only one criterion is set, the search engine looks for all records that match.  This usually 
results in a broader and therefore larger number of records. When multiple criteria are set the search engine 
looks for contacts that match ALL of the criteria.  This narrows the search and usually results in fewer 
records.
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Use the Search Engine to Find a Service Contract
The Search Engine provides a flexible and powerful way to find service contracts.   It supports “wildcards”
so that it is possible to enter just a few letters of a criterion in order to find possible matches.  A question 
mark (?) stands for any single character and an asterisk (*) stands for a number of characters.  Wildcards 
can be placed before, after, or in the middle of other characters.

In the following examples a single criterion at a time is used for searching.  Please keep in mind that you 
may narrow the amount of search results by using multiple search criteria at the same time.

Searching for Service Contracts

The Service Contract module lets you search for contracts based on number, organization, contract level, 
or contract duration.  The Found box displays the number of service contracts that meet your search 
criteria.

The following are some Contract Manager search examples:

Search by Contract Number

1. Click the Clear button to give you a blank Contract screen.

2. Enter a *3 in the Contract data entry box.

3. Click the Find button.  Contract C0000003 is displayed.

Search by Organization

1. Click the Clear button to give you a blank Service Contract screen.

2. Enter Circuits* in the Organization data entry box.  Use an asterisk before or after the name to 
represent the portion you didn’t include (e.g., *West, Scott*, *soft*).

3. Click the Find button.  The contract for Circuits West, Inc. is displayed.  If Circuits West has multiple 
contracts use the first, previous, next, and last buttons in the bottom right-hand portion of the module 
to sequence through the records.

Search by Organization Using the Drop-Down List 

1. Click the Clear button to give you a blank Service Contract screen.

2. Click the Organization drop-down arrow to see the list of organizations.  Select Aspen Testing 
Labs.

3. Click the Find button.  Contract C0000009 is displayed.  The status box in the upper right hand 
corner is red indicating that the contract is no longer valid.  This is because the End Date has passed.
If Aspen Testing Labs has multiple contracts, use the first, previous, next, and last buttons in the 
bottom right-hand portion of the module to sequence through the records.
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Use the Search Engine to Find a Service Contract (cont’d)
Search by Organization Using Lookup Tables 

1. Click the Clear button to give you a blank Service Contract screen.

2. Click the small button next to Organization to open the Lookup Table.  Double-click on any 
organization you want.  The Lookup Table will close.    

3. Click the Find button.  If the organization you selected has an invalid contract or does not have a 
service contract, the status button remains red.  The button turns green if there is a valid service 
contract.  

Search by Contract Level Using the Drop-Down List 

1. Click the Clear button to give you a blank Service Contract screen.

2. Click the Level drop-down arrow to see the list of Contract Levels.  Select Per-Incident.     

3. Click the Find button.  Two contracts are located.  One is valid.  The other has reached its Per-
Incident level.  When multiple records are found use the first, previous, next, and last buttons in the 
bottom right-hand portion of the module to sequence through the records.

Search by Contract Level Using Lookup Tables 

1. Click the Clear button to give you a blank Service Contract screen.

2. Click the small button next to Level to open the Lookup Table.  Double-click on the service level 
you want.  The Lookup Table will close.    

3. Click the Find button.  When multiple records are found use the first, previous, next, and last buttons 
in the bottom right-hand portion of the module to sequence through the records.

Search by Contract Duration Using the Drop-Down List 

1. Click the Clear button to give you a blank Service Contract screen.

2. Click the Duration drop-down arrow to see the list of contract durations.  Select Annual.

3. Click the Find button.  Six contracts are located. When multiple records are found use the first, 
previous, next, and last buttons in the bottom right-hand portion of the module to sequence through 
the records.

Search by Contract Duration Using Lookup Tables 

1. Click the Clear button to give you a blank Service Contract screen.

2. Click the small button next to Duration to open the Lookup Table.  Double-click on the duration you 
want (e.g., Annual, Monthly, Semi-Annual).  The Lookup Table will close.    

3. Click the Find button.  When multiple records are found use the first, previous, next, and last buttons 
in the bottom right-hand portion of the module to sequence through the records.

Page 33



SDS HELPDESK TUTORIAL

Use the Search Engine to Find an Issue
SDS HelpDesk has a powerful search engine that can quickly scan the database.  Search criteria can be 
as broad or narrow as desired.  You can search using category, location, condition, status, priority, 
organization name, keywords, dates, or users.

The Search Engine supports “wildcards” so that it is possible to enter just a few letters of a criterion in 
order to find possible matches.  A question mark (?) stands for any single character and an asterisk (*) 
stands for a number of characters.  Wildcards can be placed before, after, or in the middle of other 
characters.

In the following examples a single criterion at a time is used for searching.  Please keep in mind that you 
may narrow the amount of search results by using multiple search criteria at the same time.

Use the Issue Manager Search Screen

You can use the Issue Manager search screen to conduct searches of other issues or the Knowledge 
Base.  

1. Click the Search On button located in the upper right portion of the module.  This overlays the search
screen onto the problem and solution area.

2. You can search on problem and/or solution keywords.  Type “power” into the first Problem box.  
Check the small box in the upper right corner of the problem section.  This sets the keyword as a 
search criterion.

3. Click the Issue icon button to search current issues for the keyword.  The search results are 
displayed in the issue pop-up screen.  Click an issue to see a quick view of the key information.

4. Click the Clear Section button to conduct a different search.

5. Type “defect*” into the first Solution box.  Check the small box in the upper right corner of the 
solution section.  Click the large button next to Category to open the drop-down tree.  Click the (+) 
next to Telephones.  Double-click Problem.  Check the small box in the upper right corner of the 
Category section.  Click the Knowledge Base icon button to search on category AND keyword.  The
search results are displayed in the issue pop-up screen.  Click an issue to see a quick view of the key
information.

6. Click the Search Off button to close the Issue search screen.

Search by Issue Number

1. Click the Clear button to give you a blank Issue Manager screen.

2. Enter “*2” in the Number data entry box.

3. Click the Find button.  Two issues are located; one is I0000002 for Aspen Testing Labs and the other
is I0000012 for Bentley Industries.  Click an issue to see a quick view of the key information.  Click 
the Hide button to close the pop-up screen.
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Use the Search Engine to Find an Issue (cont’d)
Search by Organization

1. Click the Clear button to give you a blank Issue Manager screen.

2. Enter “*ley*” in the Organization data entry box.  Use an asterisk before and/or after the name to 
represent the portion you didn’t include (e.g., *West, Scott*, *soft*).

3. Click the Find button.  The issues that have been entered for Bentley Industries are listed in the pop-
up screen.  Click an issue to see a quick view of the key information.  Click the Hide button to close 
the pop-up screen.

Search by Organization Using the Drop-Down List

1. Click the Clear button to give you a blank Issue Manager screen.

2. Click the Organization drop-down arrow to see a list of organizations.  Select Aspen Testing Labs.

3. The contact, Troy Kilen, is displayed.  You can search on that contact, select a different contact by 
selecting the name from the Contact drop-down list, or search only on the company.  To search on 
the company, select the contact, and then press the delete key.

4. Click the Find button.  Issue I0000002 is listed in the pop-up screen.  Select the issue to see a quick 
view of key information.  Click the Hide button to close the pop-up screen.

Search by Organization Using Lookup Tables

1. Click the Clear button to give you a blank Issue Manager screen.

2. Click the small button next to Organization to open the Lookup Table.  Double-click Aspen Testing 
Labs.  The Lookup Table will close.

3. The contact, Troy Kilen, is displayed.  To search only on the company, select the contact name and 
then press the delete key.

4. Click the Find button.  Issue I0000002 is listed in the pop-up screen.  Select the issue to see a quick 
view of key information.  Click the Hide button to close the pop-up screen.

Search by Category 

1. Click the Clear button to give you a blank Issue Manager screen.

2. Click the large button next to Category to open the drop-down tree.  Click the (+) next to Internal 
MIS to see the subcategories.

3. Double-click Hardware.

4. Click the Search On button.  Check the small box in the upper right corner of the Category section.  
This sets the category/subcategory as a search criterion.  Click either the Find button or the Issue 
Icon button.  Issue I0000004 is listed in the pop-up screen.  Select the issue to see a quick view of 
key information.  Click the Hide button to close the pop-up screen.
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Use the Search Engine to Find an Issue (cont’d)
Search by Location

1. Click the Clear button to give you a blank Issue Manager screen.  If necessary, click the Clear 
Checks button to clear any check boxes.

2. Click the large button next to Location to open the drop-down tree.  Click the (+) next to Products to 
see the next level.  Click the (+) next to Multiple Line Telephones to see the next level.  Click the (+)
next to ExecuPhone2 to see the last level.  Double-click Model 1600A.

3. Check the small box in the upper right corner of the Location section.  This sets the location as a 
search criterion.  Click either the Find button or the Issue Icon button.  Issue I0000002 is listed in the
pop-up screen.  Select the issue to see a quick view of key information.  Click the Hide button to 
close the pop-up screen.

Search by Condition 

1. Click the Clear button to give you a blank Issue Manager screen.  If necessary, click the Clear 
Checks button to clear any check boxes.

2. Click the large button next to Condition to open the drop-down tree.  A plus (+) next to a Condition 
means that it has one or more values associated with it.  Click the plus (+) next to Temperature to 
see the values.  Double-click >100 degrees.  Click the large button to close the drop-down tree.  

3. Check the small box in the upper right corner of the Condition section.  This sets the condition as a 
search criterion.  Click either the Find button or the Issue Icon button.

4. Click the Find button.  Issue I0000005 is listed in the pop-up screen.  Select the issue to see a quick 
view of key information.  Click the Hide button to close the pop-up screen.

Search by User 

1. Click the Clear button to give you a blank Issue Manager screen.  Click the Search Off button to 
close the search screen. 

2. Click the User drop-down arrow to see a selection list.  Select CBROOKS.

3. Click the Find button. The search results are listed in the pop-up screen.  Select an issue to see a 
quick view of key information.  Click the Hide button to close the pop-up screen.

Search by Status Using the Drop-Down List

1. Click the Clear button to give you a blank Issue Manager screen.

2. Click the Status drop-down arrow to see a selection list.  Select Open.

3. Click the Find button.  Four issues are found.  Select an issue to see a quick view of key information. 
Click the Hide button to close the pop-up screen.
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Use the Search Engine to Find an Issue (cont’d)
Search by Status Using Lookup Tables

1. Click the Clear button to give you a blank Issue Manager screen.

2. Click the small button next to Status to open the Lookup Table. Double-click Closed.  The Lookup 
Table will close.

3. Click the Find button.  Seven issues are found.  Select an issue to see a quick view of key 
information.  Click the Hide button to close the pop-up screen.

Search by Priority Using the Drop-Down List

1. Click the Clear button to give you a blank Issue Manager screen.

2. Click the Priority drop-down arrow to see a selection list.  Select Medium.  The selection list will 
close.

3. Click the Find button.  Six issues are found.  Select an issue to see a quick view of key information.  
Click the Hide button to close the pop-up screen.

Search by Priority Using Lookup Tables

1. Click the Clear button to give you a blank Issue Manager screen.

2. Click the small button next to Priority to open the Lookup Table. Double-click High.  The Lookup 
Table will close.

3. Click the Find button.  Four issues are found.  Select an issue to see a quick view of key information. 
Click the Hide button to close the pop-up screen.
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System Administrator
If you are the system administrator, there are certain items that need to be set up when you start using 
the HelpDesk.mdb.  Please refer to the User Guide for step-by-step instructions for each of these items.  
Two of the items have been included in this tutorial.

Add New Users
Anyone who needs to be able to access SDS HelpDesk, must be entered into the system as a contact 
and then as a user by the system administrator.  Use the User Manager dialog box to add authorized 
users, allow certain users to modify key information, and to set initial user passwords.  The system 
administrator can add new users at any time.  The number of users who can access SDS HelpDesk 
concurrently is dependent upon the number of licenses you purchase.

STEPS:

1. Click the Admin menu.  Select the Users option to launch the User Manager dialog box.

User Manager Dialog Box

2. Users must be added as contacts first.  Click the Full Name title to open Address Book.  Click the 
Clear button to give you a blank Address Book screen.  The only pieces of information you must 
enter now to set up contacts as users are their name, organization, and contact type.

3. Enter your full name in the Address Book Contact box.

4. Click the small button next to Organization label to open the Lookup Table.  Double-click Packard 
Brothers, Inc.

5. Select Employee from the Contact Type drop-down list. 

6. Click the Address Book Add button to save your information to the database.

7. Close the Address Book module.  The User Manager screen should be visible.  Your name is now 
listed in the large Contacts box.
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Add New Users (cont’d)
8. Select your name.   Type a user name for you in the User Name box.  A User name must be unique.

It can be any combination of alphanumeric characters and is the name that is used when the user 
logs on.  The maximum user name length is ten characters.

9. Enter an initial password for yourself.  It is important to note that passwords are case sensitive.  Be 
sure to keep your password in a secure place. 

10. If applicable to a new user, check the appropriate boxes in the Permissions section.  If checked, the 
user will be able to carry out the function listed.  Check all three boxes. 

11. Click the Add button to save the information.  You will see your full name and user name in the large 
right-hand box.  This process is repeated for each contact you want to designate as a user of SDS 
HelpDesk.

NOTE:  Remember, contacts must be designated as users before they can logon to SDS HelpDesk and before
they can be added to an issue work group.

Add New Information to Lookup Tables
The Lookup Tables module is a convenient place to create lists of information such as issue categories, 
skills, priorities, organization names, etc.  What you enter in Lookup Tables appears in the drop-down lists
and trees throughout SDS HelpDesk.  

Pre-loading information into Lookup Tables helps to improve the accuracy of data entry since you can see
the items that have already been added.  This reduces the number of slightly different entries that 
sometimes get made. 

One of the key features of the Lookup Table Module is its flexibility.  Just choose an appropriate table, 
and then create a list of items you want to track. 

STEPS:

1. Click the Lookup Tables icon  in the toolbar to open the module. 

Lookup Table Manager
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Add New Information to Lookup Tables (cont’d)
2. Click the Skill button.  The Skill table is a list box data entry screen.

3. Any previous entries to this table are displayed in the large list box.  We want to add the skill, 
Telephone Cable Installation.  Scroll down the list to see if the skill already exists.  Since it doesn’t, 
type this skill into the Skill Description box.

4. Click the Add button, or press ALT + A to add information quickly.  The skill is added to the list and 
highlighted.

5. Click the Tab key.  This returns you to the Description box and highlights the previous entry.  

6. While the previous entry is highlighted, type in another skill.  Press 
ALT + A.  You can repeat this process until you are finished adding new items to the Lookup Table. 

NOTE:  The Skill, Status, Priority, Contact Type, Contract Limit, Contract Level, and Contract Duration 
Lookup Tables all have list box data entry screens.

7. Click the Location button.  This Lookup Table is used to specify where an issue has occurred.  It 
displays information in a tree-like format similar to Windows Explorer.  This format enables you to 
view the hierarchy of the items.

NOTE:  The left-hand box displays the various levels of items.  You can set up to four levels in the Location 
table.  A plus (+) next to a level means that there are other levels below it.  Click the (+) to see the next level.  
A minus (-) means all levels below are displayed.  We want to add another model to   

8. We want to add a new model to ExecuPhone.  Click the plus (+) next to Products.  Click the plus (+) 
next to Multiple Line Telephones.  Click the plus (+) next to ExecuPhone.

9. Select ExecuPhone, and then click the Tab key.  This takes you to the Description box and highlights
the item.  While still highlighted, enter Model 6000 in the Description box. 

10. Click the Add button, or press ALT + A.  The new model is added to the tree.

Where Do You Go From Here?
Feel free to go back and add addition data to the Demo database.  

We are interested in your comments about SDS HelpDesk, this tutorial, or our User Guide.  Please email 
your comments to us at support@ScottDataSystems.com.

If you wish to register the program, click the Help menu and select the How to Register option.  This will 
provide instructions on how to register the program and obtain a permanent license code.
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